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About this document

Scope and purpose

This application note describes the XENSIV™ BGT60LTR11AIP Radar Shield2Go (S2GO RADAR BGT60LTR11) and
gives an overview of its functions. The Shield2Go is an ultra-small Infineon Technologies PCB standard, which
comes with different ICs on it intended for different use cases.

Intended audience

The intended audience for this document are engineers, prototype creators, hobbyists and makers - basically,
anyone who wants to work hands-on with radar, but without the need to deal too much with the development
process, focusing more on the application outcome.

Reference Board/Kit

Product(s) embedded on a PCB with a focus on specific applications and defined use cases that may include
software. PCB and auxiliary circuits are optimized for the requirements of the target application.

Note: Boards do not necessarily meet safety, EMI, quality standards (for example UL, CE) requirements.
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Important notice

Important notice

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board (PCB) for
demonstration and/or evaluation purposes, which include, without limitation, demonstration, reference and
evaluation boards, kits and design (collectively referred to as “Reference Board”).

Environmental conditions have been considered in the design of the Evaluation Boards and Reference Boards
provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards has been tested
by Infineon Technologies only as described in this document. The design is not qualified in terms of safety
requirements, manufacturing and operation over the entire operating temperature range or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the same
procedures as regular products regarding returned material analysis (RMA), process change notification (PCN)
and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for
evaluation and testing purposes. In particular, they shall not be used for reliability testing or production. The
Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards (including but
not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other requirements of the
country in which they are operated by the customer. The customer shall ensure that all Evaluation Boards and
Reference Boards will be handled in a way which is compliant with the relevant requirements and standards of
the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and managed
according to the terms and conditions set forth in this document and in other related documentation supplied
with the respective Evaluation Board or Reference Board.

It is the responsibility of the customer’s technical departments to evaluate the suitability of the Evaluation
Boards and Reference Boards for the intended application, and to evaluate the completeness and correctness
of the information provided in this document with respect to such application.

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not cause
any harm to persons or third party property.

The Evaluation Boards and Reference Boards and any information in this document is provided "as is" and
Infineon Technologies disclaims any warranties, express or implied, including but not limited to warranties of
non-infringement of third party rights and implied warranties of fitness for any purpose, or for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation Boards
and Reference Boards and/or from any information provided in this document. The customer is obliged to
defend, indemnify and hold Infineon Technologies harmless from and against any claims or damages arising
out of or resulting from any use thereof.

Infineon Technologies reserves the right to modify this document and/or any information provided herein at
any time without further notice.
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Safety precautions

Safety precautions

Note: Please note the following warnings regarding the hazards associated with development systems

Table1 Safety precautions

Caution: The reference board contains parts and assemblies sensitive to electrostatic
discharge (ESD). Electrostatic control precautions are required when installing, testing,
servicing or repairing the assembly. Component damage may result if ESD control
procedures are not followed. If you are not familiar with electrostatic control
procedures, refer to the applicable ESD protection handbooks and guidelines.
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Introduction
1 Introduction
1.1 Overview

The Radar Shield2Go can be used independently as a “plug-in” radar sensor (e.g., with Arduino form factor
boards or another microcontroller) to detect motion and direction of motion by using only two GPIOs (TD and
PD) in autonomous mode (default). The board comes with two potentiometers and switches, making it easy to
adjust the four QS signals of the radar mechanically. The switches can be used to switch between autonomous
and SPI modes.

The Shield2Go comes with castellated holes to ensure several connection styles.

The Shield2Go family is recommended to be used with either Infineon’s XMC™ maker board series (e.g.,
XMC1100 Boot Kit/XMC1400 Arduino/XMC 2Go/XMC4700 Relax Kit) or Arduino boards (e.g., Rev3/MKR1000).

The BGT60LTR11AIP Shield2Go demonstrates the features of the BGT60LTR11AIP MMIC and gives the user a
“plug and play” radar solution.

Figure 1 Radar Shield2Go with BGT60LTR11AIP

1.1.1 Hardware and third-party software

The Radar Shield2Go is compatible with the Arduino IDE, Platform.lO with Arduino extension, and Infineon’s
ModusToolbox™ (formerly Cypress) SDK. You can find a detailed user guide to integrate the BGT60LTR11AIP
library on the free and open-source repository GitHub [4].

Note: To use the existing library in Infineon’s ModusToolbox™ SDK, the integration is done manually with
customized manifests, described on Infineon’s GitHub.

The Shield2Go concept can also be attached to any board with an Arduino Uno form factor, by using an
Infineon MyloT adapter.
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1.1.2 Quad-state input pins

The MMIC has four quad-state input pins (QS1 to QS4) that give the performance parameters flexibility when it
is running in autonomous mode. These pins are used to configure the chip, as explained in Section 4.2.2.

QS1 sets up the three modes of the MMIC (autonomous by default), QS2 controls the detector comparator
threshold, QS3 sets up the hold time of the “target detect” output, and QS4 is used to select the device
operating frequency by configuring the phase-locked loop (PLL).

QS1lis controlled by a dual-state switch and QS4 by a tri-state switch. QS2 and QS3 can be adjusted by two
rotatable potentiometers.

In autonomous mode, the detection threshold (set via potentiometer R_QS2) has 16 different levels to fulfill a
configurable detection range from 0.5 m up to 7 m with a typical human-target radar cross-section (RCS). The
hold time is also configurable as 16 levels in autonomous mode via the potentiometer that controls QS3, which
allows detection status to be held for up to 30 minutes (see Section 4.2.5).

1.1.3 SPl communication

The MMIC also supports SPI mode by changing the operation mode with the QS1 pin (see Section 4.2.3). In this
mode, the raw radar data can be extracted from BGT60LTR11AIP for signal processing on a PC or an external
MCU using SPI. This sampled radar data can be used to develop customized algorithms. The SPI mode offers
the possibility to control the MMIC radar completely via SPI.

1.2 Key features

e Easy motion and direction of motion detection of an object with only two GPIOs

e Programmable in Arduino IDE and Platform.lO (VS Code extension)

e Configurable detection range from 0.5mto7 m

e LEDs that blink when presence or movement direction is detected

e Potentiometers and switches to adjust the settings of the radar (QS)

e Super-small (48.80 mm x 23.90 mm) board design with Infineon’s Shield2Go format
e 60 GHz transceiver BGT60LTR11AIP MMIC with one transmitter and one receiver unit

1.3 Potential applications

e Prototyping smart home appliances
e Security applications
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2 Board and pin-out overview

This section gives an overview of Infineon’s standardized Shield2Go pin-out.

The

g
BGT60LTR11AIP Radar Infineon
Shield2Go

BGT60LTR11AIP

'VTUNE Test Pad

Pull-up/down resistors R14-R18
[PLL_Trig, MOSI, SPI_SCK]

Ground pins on board |Adj. Low-Pass Filter [IFI & IFQ]
connected with each other.

{ Sample & Hold Capacitors|

Direction Indicator LED ! ; ﬁp"{"f" Reff'?t?'S F?}:R22|
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Legend Tri-State Switch QS1: mode byl ,
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/| Labelling of Pins in Datasheet RE
[/ Pin Number in Arduino IDE |/ IFIP13- AN1
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. NC
A Warning Eround
@ Additional Information = S
Div | IRQIPS < INT/GPIO3
Not Connected Phase_Det}P8 4 PWM/GPIO4

|LDO 3.3v/1.5v

A The maximum voltage on any pin is 4 V.
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g www.infineon.com
Figure 2 The BGT60LTR11AIP Radar Shield2Go (top view)
2.1 Board dimensions
—
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=
o
o
0
N
Figure 3 Layer stack-up of the BGT60LTR11AIP Radar Shield2Go
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3 Getting started
3.1 Overview

The Radar Shield2Go needs an MCU to communicate and run custom code. However, if connected to a power
source, the direction and motion LEDs blink in the presence of an object even without an MCU connected. The
target detect (TD) pin is an active low pin. Hence, when no target is detected, the voltage level appears to be
3.3V on this pin. The phase detect (PD) pin voltage varies, depending on the direction of the moving object.
While the target is approaching, the pin puts out 3.3V, and when the target is departing from the radar, it puts
out close to 0 V. These pins can be read from analog pins or digital pins TD and PD.

Move the switch lever “QS1: mode” to the left position to set up the radar in autonomous mode, and apply 3.3V
(pin 7) and GND (pin 6) to the corresponding power pins of the Shield2Go. Note that the power source offers a
minimum of 150 mA. If power is supplied, the PWR LED turns on. Now, the radar can recognize any movement
or direction of an approaching or departing object. The blue LED lights up when object movement is detected,
and the red LED lights up when the target is approaching or departing. See Section 5.3 for more information
about LED behavior.

The radar now works on its own, without any other MCU needed. However, for reading/writing the radar MMIC,
connect one of the recommended MCUs mentioned in Section 1.1.1. Note that any MCU will work if the voltage
levels are the same (3.3 V), otherwise level shifting is mandatory. Because Infineon offers software libraries
compatible with Arduino and Infineon XMC™ boards, software setup for other MCU platforms might be more
difficult.

Infineon’s software libraries and installation guides are open-source and available on Infineon’s GitHub
channel [4]. The Radar Shield2Go needs to be connected with the pin headers of the MCU board either with
wires or via stacking onto an adapter (e.g., Infineon’s MyloT adapter for Arduino).

3.2 Hardware setup

Connect the Radar Shield2Go to any microcontroller and supply the board with a 3.3V DC (150 mA) power
source (which can usually be driven by the MCU board).

Figure 4 Radar Shield2Go on top of Infineon’s MyloT adapter and Arduino-compatible XMC1100
Boot Kit (very bottom)
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Shield2Go Slot .
w3
51
1 [ 5V Active
IFI 2 | AN1 TX | 10  User lED 12
IFOQ 3 AN2 FX | 11 Ok
4 | sDA RST/GPIO2_| 12 %1 RST
5 | scL GPIO1_| 13 Tarpet Det Out
6 | GND CS | 14 S1 SPI CSN
T GNDI—5T3v3 SCLK | 15 81 SPI CLK
= ST IRQ § | INT/GPIO3 MOSI | 16  S1 SPI MOSI
Phase Det Out 0 | PWM/GPIO4 MISO_| 17 §1 SPI MISO
Shield2Go-52G-14
Figure 5 Shield2Go connector S1 schematics

After that, connect the microcontroller board via USB to your computer and continue with the software setup as
described in Section 4.

Note: By using Infineon’s MyloT adapter, you can easily plug up to three Shield2Gos on an Arduino Uno
Rev3 form factor due to the integrated level shifter on the adapter. The adapter works with 5V
(e.g., Arduino Uno Rev3) and 3.3 V shields (e.g., XMC1100 Boot Kit/XMC4700 Relax Kit). Please read
the MyloT adapter manual for more details on how to configure the voltage shifting.

The following boards are recommended for use and are compatible with the Arduino IDE and Platform.lO

Software and Code on
github.com/infineon

@ 7o ofVei@
@ zed C[evei@m
@ ced ‘e
@ e 50 @

@ zves
@ sed
@ s
- Vi

uu.infineon.com/xmc

()
()
-
-
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=
x

XMC2Go XMC1100 Bootkit XMC4700 RelaxKit

Figure 6 Recommended boards
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e XMC2Go is equipped with Infineon’s powerful Arm® Cortex®-M0 based microcontroller XMC1100 and is the
ideal board in Shield2Go form factor for tiny applications.

e XMC1100 Boot Kit or XMC1400 Arduino are powerful microcontroller boards with Arduino Uno Rev3 form
factor that offer the user more performance and GPIOs, including multiple buses (12C, SPI), pulse-width
modulation (PWM) signals, ADC, DAC, LEDs, and a breakable and reusable debugger for multiple purposes.

e XMC4700 Relax Kit is an extremely powerful microcontroller board with Infineon’s Arm® Cortex®-M4 based
microcontroller XMC4700. It also comes in an Arduino Uno Rev3 form factor, with an additional 80 GPI1Os to
use, and Ethernet.

% You can also use Arduino’s boards, such as the popular Arduino Uno Rev3 or the MKR1000
Wi-Fi board. We have prepared examples of applications on the do-it-yourself website
ARDUINO  Hackster.lO for you - check out the infineon_team Channel for more information.

‘ ’ Find all libraries and instructions to get started on Infineon’s GitHub repository.

3.3 Software setup

3.3.1 Required software for Infineon’s XMC™ boards

e SEGGER J-Link, either for Windows or Linux (for XMC™)
e Arduino IDE, either for Windows or Linux
e XMC-for-Arduino (installed with Arduino IDE)

e Radar BGT60LTR11 Library for Arduino on Infineon’s GitHub repository (installed with Arduino IDE, v2.0.0 or
higher)

e Follow these installation steps:
- Install Arduino IDE. If you are new to Arduino, please download the program and install it first.

- Install XMC™ board. The official Arduino boards are already available in the Arduino software, but other
third-party boards such as the Infineon XMC™ MCU-based board need to be explicitly included. Follow
the instructions in the link to add the XMC™ board family to Arduino.

- Install the library. In the Arduino IDE, go to the menu Sketch > Include library > Library Manager. Type
BGT60LTR11 and install the library.

- Additionally, install SEGGER J-Link if you are using an Infineon XMC1100 Boot Kit or XMC4700 Relax Kit.
Continue with the section below if you are using Infineon’s XMC™ microcontroller for Arduino.

3.3.2 Required software for Arduino

e Arduino IDE, either for Windows or Linux

e Radar BGT60LTR11 Library for Arduino on Infineon’s GitHub repository (installed with Arduino IDE, v2.0.0 or
higher)

e Follow these installation steps:
- Install Arduino IDE. If you are new to Arduino, please download the program and install it first.

- Install the library. In the Arduino IDE, go to the menu Sketch > Include library > Library Manager. Type
BGT60LTR11 and install the library.
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- Additionally, install SEGGER J-Link if you are using an Infineon XMC1100 Boot Kit or XMC4700 Relax Kit.
Continue with the section below if you are using Infineon’s XMC™ microcontroller for Arduino.

3.3.3 Installation instructions for XMC™ microcontrollers

You can also find the whole XMC-for-Arduino installation guide for Infineon’s XMC™ repository on GitHub.

3.3.3.1 Prework for SEGGER J-Link

In order to use and program the Infineon XMC™ microcontrollers in the Arduino IDE, SEGGER J-Link must be
installed on your PC. Please follow this link to SEGGER J-Link and install the J-Link software and
documentation pack for your operating system. If you have already installed DAVE™ - Development Platform
for XMC™ Microcontrollers you can skip this step, as the respective drivers/programs are already installed on
your system.

[ J-Link Software and Documentation Pack

® Allin-one debugging solution

* Can be downloaded and used free of charge by any owner of a SEGGER J-Link. J-Trace or Flasher model.
Not all features of It may be available on all |-Link / J-Trace / Flasher models.

® Updated frequently
* Release Notes
= More information

& Click for downloads

[2018-03-23] 31,211 KB

@ J-Link Software and Documentation pack for Windows "j’c"x” & DOWNLOAD
Installing the software will automatically install the j-Link USS drivers and offers to update applications which It —
use the J-Link DLL Multiple versions of the J Link software can be installed on the same PC without problems;
they will co-exist in different directories.
@ J.Link Software and Documentation pack for macOS V6.30i [2018-03-23] 29,134 KB & DCOWNLOAD
Feees
. . o . . . . ™ .
Figure 7 Arduino configuration - installing J-Link software for XMC™ microcontrollers (not needed
o
for Arduino)
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3.3.3.2 Using Arduino IDE with XMC™ microcontroller

Edit Sketch Tools Help

Mew

Open...
Open Recent
Sketchbook
Examples
Close

Save

Save As...

Page Setup
Print

Ctrl+N
Ctrl+0
2
]
) [z, to run once:
Ctrl+W
Ctrl+5

Ctrl+Shift+5
e, to run repeatedly:

Ctrl+Shift+P
Ctrl+P

Preferences

Ctrl+Comma I

Quit

Ctrl+Q

Figure 8 Arduino IDE configuration - Preferences

Paste the following URL into the “Additional Boards Manager URLs” input field under File > Preferences to add
Infineon’s microcontroller boards to the Arduino IDE. (It is easier to copy - there is no clickable link.)

https://github.com/Infineon/XMC-for-Arduino/releases/latest/download/package_infineon_index.json

Note: The former “package_infineon_index.json” URL will no longer be maintained after version 1.4.0.
Upcoming versions will not be shown as available in the board manager.
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Sketchbook location:

Your Sketchbook

Editor language: :Sysbem Default - (requires restart of Arduino)

Editor font size: 12

Interface scale: [¥] Automatic | 100 - % (requires restart of Arduino)

Show verbose output during: [~ compilation [~ upload

Compiler warnings: Mone =

[ Display line numbers

[ Enable Code Folding

Verify code after upload

[ Use external editor

Check for updates on startup

Update sketch files to new extension on save (.pde -> .ina)
Save when verifying or uploading

Additional Boards Manager URLs: |Here, please.
LR ol iy i g
C:\Users\AppData'Local \Arduino 15 preferences. txt

(edit only when Arduine is not running)

Figure 9 Arduino IDE configuration - Additional Boards Manager URLs

To install the boards, please navigate to Tools > Board > Boards Manager... and search for “XMC”. You will find
options to install the board files for the microcontrollers. Click Install to add the boards to your Arduino IDE.

Type Al - | [me

XMC Microcontroller by Infineon version 0.4.0 INSTALLED
Boards included in this package:
¥MC 1100 Boot Kit, XMC 1100 XMC2Go, XMC 4700 Relax Kit.

Cnline help
More info

Select version Install Remove

Figure 10 Arduino configuration - installing XMC™ library

User guide 13 Revision 1.20
2024-10-17


https://raw.githubusercontent.com/infineon/assets/master/Pictures/Preferences_JSON.png
https://raw.githubusercontent.com/infineon/assets/master/Pictures/Boards_Manager_Entry.png

o _.
S2GO RADAR BGT60LTR11 |nf|n90n
XENSIV™ BGT60LTR11AIP Radar Shield2Go
Getting started

In the boards listed under Tools > Board, the XMC™ microcontroller boards are added and can be used from
now on.

(& vene arsere I ===

Aute Format

Ctrl+T

Archive Sketch
Fix Encoding & Reload
void setup() Serial Menitor Ctrl+Shift+M

// PUE YOUE ool Plotter Ctrl+ Shift+L

4 WiFiL01 Firmware Updater

void loop() { ESP8266 Sketch Data Upload n
// put your i i
LilyPad Arduino USB
Board: "XMC1100 XMC2GO" ) i D

1 Port ) LilyPad Arduino
Get Board Info Arduino Pro or Pro Mini
Arduino NG or older
Programmer: "USBasp” ! Arduino Roebot Control
Burn Bootloader Arduino Robot Motor

Arduino Gemma

Adafruit Circuit Playground
Arduine Yin Mini

Arduine Industrial 101

Linino One

XMC Family
XMC1100 Boot Kit
@ XMC1100 XMC2GO

KMCA700 Relax Kit
7

XMET1C ]

Figure 11 Arduino configuration - choose your XMC™ board

Note: This integration will only work for Arduino IDE 1.5 or above.
The XMC1100 Boot Kit has limitations compared to the official Arduino boards (consult the XMC-
for-Arduino Wiki for more information).
Refer also to the LICENSE.md/txt file for further information.
Arduino 1.8.0 IDE might have problems with the XMC-for-Arduino releases.XMC-for-Arduino support
for “arm-linux-gnueabihf” is only up to version 1.1.
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4.1

Radar modes setup

TD and PD signals

With the Shield2Go you can adjust all four quad-state signals (QS1 to QS4) mechanically rather than via
software. Use the potentiometers and switches to adjust all quad states in autonomous mode. In SPI mode,

you can adjust all QS signals by changing the BGT60LTR11AIP registers.

The default direction information is set to “approaching”. The truth table for the output pad voltage is shown in

Table 2.

Table 2 Truth table for the output pad voltage

Output pad voltage Motion Approaching/Departing
TD PD

high high No N.A.

low low Yes Departing

low high Yes Approaching

The BGT60LTR11AIP provides four quad-state inputs, QS1 to QS4. With one quad-state input, it is possible to
get four states from one input pin. These pins are used to configure the chip.

4.2

“Advance mode” and quad-state inputs

On reset of the digital main controller and during the initialization sequence some chip input pins are sampled
to determine the configuration the chip should start with. Figure 12 shows the schematics of the default
configuration for the MMIC operation modes and settings.

VDD RF VDD RF VDD RF VDD_RF
VDD RF o
s < - n.m. 2 QS2
83 & T 14 < 16
. | A
| | | 1 3
S| bR o bR 2 [ ook = [ Jrook =
GND = — R_QS2 10k i
— — [_q _Q -
o /M m | = GND
= = g = | o
=} e =1 e ]
- e S - = = s H
2 T8 2-\& 0o [Rs & [Rv
& 15ym ) Al | Jlook A 100k
w w
| C C n.m
oLl VDD _RF
o — = T 2 QS3
2 i GND GND !
1 ¥ 3
P i
R _QS3 10k GND
Figure 12 MMIC operation modes and settings (n.m. = not mounted)
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4.2.1 “Advance mode”

When the PLL_Trig pin is “0” as the digital main controller wakes up from reset, the chip boots in basic mode
(not advance mode). When the pin is kept at “1” during chip boot and QS1 is either GND or OPEN, pins SPIDI
and SPICLK are also sampled to determine the PRT: dc_rep_rate (Reg7[11:10]). In addition, pins QS2 and QS3
are evaluated by the ADC and converted into 4-bit values before each “mean window”.

By default, the Radar Shield2Go is pulled to VDD_RF (1.5 V) with a 100 kQ resistor R14; hence, “autonomous
mode” is activated. Additionally, “advance mode” is activated.

When this pin is 0, when the digital main controller wakes up from reset, the chip boots like earlier versions,
only considering the four quad-state inputs below with their 2-bit information per pin.

Table 3 PRT in “advance mode”

PLL_Trig SPI_MOSI SPI_CLK dc_rep_rate

0 * * 1/2 (fuse dependent)
1 0 0 1

1 0 1 3

1 1 0 0

1 1 1 2

4.2.2 Quad-state basics for adjustable QS1 to QS4 signals

QS1: mode

Py :
auto M SPla s ee e == M

: 1 I Motion ¥ .-
|

hold
JE o Sime it

R QS1ms’ ) R _QS4

Switch QS1:

Switch QS4:
mode witch Q

mode

Potentiometer R_QS2: Potentiometer R_QS3:
threshold Hold time

Figure 13 Overview of QS1 to QS4 signals on the BGT60LTR11AIP Radar Shield2Go from the top

The quad-state inputs QS1 to QS4 enable configuration of four different states with one input pin. Figure 13
shows the two switches QS1/QS4 and two potentiometers for the detector threshold (QS2) and hold time (QS3).
Table 4 shows possible input states and the resulting internal signals in the binary description. Quad-state
inputs are sampled at the start of the initialization sequence by the internal main controller at power-up. A
change after this sampling has no effect. Resampling can be triggered by setting the reset pin or activating the
soft reset by writing the corresponding bit in Regl5. The reset pin is by default pulled to Vpp (3.3 V) via the 10 kQ
resistor R12.
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In order to have up to 16 settings for QS2 (threshold) and QS3 (hold time), the PLL_TRIG should be connected to
Voo by removing R15 and placing R14 = 100 kQ. This will put the MMIC into “advance mode”. Note that advance
mode is set by default.

4.2.3 QS1 - MMIC operation modes

QS1is used to select the mode of the chip. By default, it is recommended to use either (advance) autonomous
mode or SPI mode. Advance mode allows the use of 15 instead of four threshold values for QS2 (threshold) and
QS3 (hold time). By default, this board comes with autonomous (advance) and SPI mode settings. Change
resistor R_QS1 to enable/disable the other modes, by soldering it, accordingly, as described in Table 4.

Table 4 QS1 settings
Switch position - Qs1 Operation mode of the | PCB configuration
QS1 mode MMIC
Left position (floating) Open (default) Autonomous pulsed Not important (default)
mode
Right position 100 kQ to Vop SPI mode with external R_QS1*=100kQO
9.6 MHz clock enabled
(FH3840024Z7)
Right position Voo SPI mode R_QS1*=0Q (default)

*R_QS1is assembled with 0 Q, 0603 (imp.)

4.2.4 QS2 - detector threshold

QS2is used to select the detector threshold value; with the same radar cross-section as a target, a lower
detector threshold value corresponds to a higher detection range, which is written into Reg2 as described in the
user guide to BGT60LTR11AIP [2].

Additionally, QS2 can be controlled by the 10 kQ potentiometer R_QS2 to adjust the detector threshold. To
increase the voltage, turn the knob counterclockwise; to reduce the voltage, turn the knob clockwise.

Rotate potentiometer R_QS2 clockwise to reduce the detection threshold.
Rotate it counterclockwise to increase the detection threshold.

Figure 14 Rotation direction of R_QS2 potentiometer - detector threshold

Note: A low detection threshold results to a higher detection range and vice-versa.
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Table5 QS2 settings - detector threshold

Pad Detector threshold

0*Vpp/16 — 1*Vpp/16 61 (right endpoint of potentiometer)
1*Vop/16 - 2*Vpp/16 66

2*Vpp/16 - 3*Vpp/16 80

3*Vpp/16 - 4*Vpp/16 90

4*\lpp/16 - 5*Vpp/16 112

5*Vpp/16 - 6*Vpp/16 136

6*Vpp/16 — 7*Vpp/16 192

T*Vbp/16 - 8*Vpp/16 248

8*Vpp/16 - 9*Vpp/16 320

9*Vpp/16 - 10*Vpp/16 384

10*Vpp/16 - 11*Vpp/16 480

11*Vpp/16 - 12*Vpp/16 640

12*Vpp/16 - 13*Vpp/16 896

13*Vpp/16 - 14*Vpp/16 1344

14*Vpp/16 — 15*Vpp/16 1920

15*Vpp/16 - 16*Vpp/16 2560 (left endpoint of potentiometer)

Due to mechanical tolerances and manufacturing differences in the potentiometer, it is difficult to predict the
degree of rotation of the potentiometer. Table 6 gives an orientation for the configuration of the threshold,
hence the radar detection range. Please note that your values may differ slightly from the values below.

Table 6 Measured threshold vs. range of Radar Shield2Go in autonomous (advance) mode (for
reference only)

Measured potentiometer | Measured potentiometer | Expected detection | Comment
voltage “VDD_RF-QS2” (V1)| voltage “GND-QS2” (V2) |range

1.412V 0.173V 7.66m Rightmost position
1.378V 0.207V 6.9m -

1.296V 0.289V 5.8m -

1.144V 0.441V 54m -

0.929V 0.656V 476 m -

0.794V 0.791V 4.1m -

0.665V 0.92V 2.48m -

0.577V 1.008V 2.1m -

0.388V 1.197V 1.7m -

0.229V 1.357V 12m -

0.108V 1477V 0.93m -

ov 1.585V 0.45m Leftmost position
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4.2.5 QS3 - detector hold time

Rotate the knob of potentiometer R_QS3 clockwise to reduce the
detection hold time.
Rotate it counterclockwise to increase the detection hold time.

Figure 15 Rotation direction of R_QS3 potentiometer - detector hold time

QS3is used to select the hold time of the TDet output, and it is written into Regl0 as described in the user's
guide to BGT60LTR11AIP [2].

Table 7 QS3 settings - detector hold time

Pad Detector hold time

0*Vpp/16 — 1*Vpp/16 100 ms (right endpoint of potentiometer)
1*Vop/16 - 2*Vpp/16 500 ms

2*Vpp/16 - 3*Vpp/16 1s

3*Vpp/16 - 4*Vpp/16 2s

4*\lpp/16 - 5*Vpp/16 3s

5*Vpp/16 - 6*Vpp/16 5s

6*Vpp/16 — 7*Vpp/16 10s

T*Vbp/16 - 8*Vpp/16 30s

8*Vpp/16 - 9*Vpp/16 45s

9*Vpp/16 - 10*Vp/16 1 min.

10*Vpp/16 - 11*Vpp/16 90s

11*Vpp/16 - 12*Vpp/16 2 min.

12*Vpp/16 - 13*Vpp/16 5 min.

13*Vpp/16 - 14*Vpp/16 10 min.

14*Vpp/16 - 15*Vpp/16 15 min.

15*Vpp/16 - 16*Vpp/16 30 min. (left endpoint of potentiometer)
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Due to mechanical tolerances and manufacturing differences in the potentiometer, it is difficult to predict the
degree of rotation of the potentiometer. Table 8 gives an orientation for the configuration of the QS3 voltage,
hence the radar’s hold time. Please note that your values may differ slightly from the values below.

Table 8
only)

Measured voltage vs. hold time of QS3 potentiometer in autonomous mode (for reference

Measured potentiometer

Expected detector

Measured detector

Comment

voltage QS3 hold time hold time

ov 100 ms Lessthanls Rightmost position
0.112V 500 ms Lessthan1ls -

0.279V 1s 1.37s -

0.355V 2s 2.21s -

0.493V 5s 5.54s -

0.713V 30s 30s -

0.898V 60s 60s -

1.06V 90s 90s -

1.134V 2 min. 2min. -

1.248V 5 min. 5 min. -

1.452V 15 min. 15 min. Leftmost position
4.2.6 QS4 - operating frequency

QS4 is used to select the device operating frequency by configuring the PLL. Frequency is also dependent on
the Japan e-fuse. The QS4 signal can be adjusted by using the tri-state switch “QS4: freq” on the Radar

Shield2Go.

Table 9 QS4 settings - operating frequency

Switch position - QS4 Qs4 Operating PCB configuration
mode frequency

Left position Ground 61.1 GHz Not important
Middle position (floating) Open (default) 61.2 GHz Not important

Right position 100 kQ to Viop 61.3 GHz R_QS4 =100 kQ
Right position Voo 61.4 GHz R_QS4 =0 Q (default)

*DNP =R_QS4 is assembled by default with a 0 Q resistor. Exchange for a 100 kQ [0603 size imp.] resistor.
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5 Hardware circuits

5.1 Power supply

This Shield2Go needs to be connected to a 3.3V DC power supply that provides at least 150 mA. Connect +3.3V
to pin 7 and ground to pin 6 (GND).

The BGT60LTR11AIP Shield2Go is equipped with a 150 mA Infineon LDO TLS202A1 that provides the necessary
1.5V for theradar IC, as seen in Figure 16.

3X3
LDO
Vin 1V5 LDO VDD PLL VDD RF
Gl ?
1] S +
G e Hee | (de, Lo Lo
T nT : 100nF —T~ 1000F
=1 :l: TLS202A1IMBV I

GND GND GND 4 GND GND GND
7k
GND
Figure 16 Power supply circuit
5.2 Level shifters

The Radar Shield2Go is equipped with 3.3 Vto 1.5V level shifters. The level shifters are responsible for
transforming the voltage signals to 3.3 V. Hence, all inputs/outputs of the Radar Shield2Go work only with 3.3V
voltage levels. For use with, e.g., 5V levels, further level shifting is required. The level shifting on the
BGT60LTR11AIP Shield2Go is shown in Figure 17.

Infineon’s MyloT adapter offers the perfect solution for such a purpose, and is capable of transforming 3.3V to
5V, making the Shield2Go usable with 5V boards. See the MyloT adapter manual for more information.
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Figure 17 Level shifter circuit (3.3 Vto 1.5V, and vice versa)
5.3 LEDs

The Radar Shield2Go comes with four different LEDs:

The green PWR LED indicates that the +3V3 pin is connected to a power supply.
[ ]

the blue motion LED indicates any movement detected by the radar,
e while the red direction LED indicates an approaching or departing object.

Table 10 shows the behavior of the motion (blue) and direction (red) LEDs, in case the MMIC radar detects an

object’s presence or its direction of movement.

Table 10

LED behavior when a movement or target is recognized by the BGT60LTR11AIP MMIC

LED Mode Comments

Blue - motion On - target detected

Off - target not detected

TDis an active low signal

Red - direction On - depart departing

Off - target approaching

PD is an active low signal
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The motion LED and direction LED are directly connected to target detection pin 13 (TD) and phase detection
pin 9 (PD). The shield has two LEDs to indicate the motion detection (blue) and the target’s direction of motion
(red), as shown in Table 10. R10 and R11 are current-limiting resistors. The digital block within the detector in
the MMIC evaluates and sets the TD/PD outputs of the BGT60LTR11AIP MMIC. Target detected (TD) output is
active low. It is set to low when enough events on the pulse train are counted. Phase detected (PD) output is
used to show the direction of the detected target. It is only valid in the case of a detected target, and it is set to
high for approaching targets and low for departing targets.

AN
- — UserLED
: LEDs
; Y‘}l&n Vin Vin
2
g
- s
1
30R
[:EZ 10 11
30R 100R 30R
=
g [ o Bl H
E LEE1pgl a PWR Motion Direction
= . | Blue Red
A . 2N Y
= o
B (ol ] 5
[Target Det Out hase Det Out

Figure 18 LED schematics

For the TD pin, when no target is detected, the voltage level appears to be 3.3V on this pin. The PD pin voltage
varies, depending on the direction of the moving object. While the target is approaching, the pin puts out 3.3V,
and when the target is departing from the radar it puts out close to 0 V. These pins can be read from analog pins
or digital pins TD and PD.

Additionally, the yellow LED1 can be controlled with P10 via an external GPIO of a microcontroller and serves as
a custom user LED. Unsolder jumper J1 if you want to disconnect LED1 from P10. Figure 18 shows the
schematics of the four LEDs.

5.4 Crystal oscillator

The MMIC requires an oscillator source with a stable reference clock providing low phase jitter and low phase
noise. The oscillator is integrated inside the MMIC. This saves current consumption, as crystal oscillators
consume only a few milli-amperes and run continuously. The Radar Shield2Go uses a 38.4 MHz crystal
oscillator, as seenin Figure 19.

N |
I

| . |
| 38.4 Mhz Oscillator |
|

| |
| |
! 4 Y1 FH3840024Z Cle i
} 11 Xosc ai 1 I 3 Xosc ao || !
! [ ] 2 || 4 1 ]

| = 1ipF — — l6pF = i
! GND 1 1 GND 3
| — —

| = - |
o ffifiie___GND___________GND . 1

Figure 19 Oscillator circuit with 38.4 MHz crystal
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5.5 External capacitors

The BGT60LTR11AIP MMIC is highly duty-cycled and performs a sample and hold (S&H) operation for lower
power consumption. The S&H switches are integrated into the chip at each differential IQ mixer output port.
They are controlled synchronously via the internal state machine. The capacitors between S&H and the high-
pass filter (HPF) are external. C10, C11, C14, and C15 are 5.6 nF capacitors used as “hold” capacitors for the S&H
circuitry. They can be configured for different pulse-width settings, as shown in Figure 10. C8, C9, C12, and C13
are the DC blocking (or high pass) capacitors. They are 10 nF to get a high pass of 4 Hz (if internal high-pass
resistor RHP =4 MQ). It is not recommended to use higher values, as it will affect the analog baseband (ABB)
settling time. The DC blocking capacitors are important because the mixer output has a different DC voltage
than the internal ABB.

C9
IFlq P IFQ PostLPF  IF1i P || IFI PostLPF
[l

Cg
||
H
l 10nF l 10nF
C10 Cl11
5.6nF I.an

GND 12 GND C13

IFlg N | [FQx PostLPF I[F1li N IFIx PostLPF
J_T_{ = I__
10nF 10nF
C14 Cls
:E.GDF 5.6nF

GND

0
g

Figure 20 External capacitors on the BGT60LTR11AIP Radar Shield2Go

In Figure 20 the external hold (C,;4) @nd high-pass capacitors (Cyp) are shown for all four branches in the
differential IQ configuration.

Table 11 Recommended hold capacitors (C10, C11, C14, and C15) for different pulse widths (PW)
Pulse width (us) Hold capacitor value (nF)

3 4.7

5 (default) 5.6 (default)

10 15

Charging time of the hold capacitor (Cp;4) is limited to the selected pulse width. Shorter pulse widths require
smaller Cp1q to get it ~ 90 percent charged during one pulse. Rise-time is controlled by the Cj,;4 itself, and the
internal mixer output resistance of 300 Q in each branch.
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IFIAiX

External capacitors

Figure 21 Internal circuit of the BGTGOLTR11AIP connected with adjustable external capacitors

Longer pulse width can have a higher Cj,,;4 value. This leads to a reduced bandwidth of the RC filter
(Rmixer out and Cpp14). Consequently, there will be lower baseband noise because of reduced noise folding
bandwidth.
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6.1

PCB design

Layer stack-up and routing

Mame

Top Cverlay
Top Solder
L1_Top
Dielectric 3
L?_GND
Dielectricl
L3_PWR
Dielectric 4
L4_Bot
Bottom Solder

Bottom Cverlay

Material

Solder Resist

Solder Resist

Type
Cveray

- Solder Mask
- || Signal

- Core
- || Signal

' Prepreg
- | Signal
- Core
- | Signal
+ Solder Mask

Overay

Weight

Thickness

0.02mm
0.035mm
0.56mm
IELT
0.23mm
0.035mm
0.56mm
0.035mm

0.02mm

Figure 22

The PCB is designed with a four-layer stack-up with standard FR4 material. Figure 22 shows the different layers

Layer stack-up of the BGTGOLTR11AIP Radar Shield2Go

and their thicknesses. In the routing on the PCB, the VTUNE pin on the BGT60LTR11AIP MMIC should be left
floating. Any components added to the line, or a long wire connected can result in spurs.

The MMIC is very sensitive to noises and electrical influences; therefore, the GND and PWR layers were

separated from the signal layers (top and bottom). Additionally, to guarantee best performance of the radar, an

elliptical space of 4 to 5 cm around the MMIC was kept free from any PCB components (except the power
capacitors).

6.2 Bill of materials

Table 12 Bill of materials

Qty | Designator Package Package Value Manufacturer order
metric imperial number

1 C4 1005 0402 11 pF GRM1535C1H110GDD5

1 C16 1005 0402 16 pF GRM1535C1H160GDD5

1 Direction 1608 0603 Red LSM0603412V

1 Gl TLS202A1MBV TLS202A1MBV

1 LED1 Yellowish green SML-P12MTT86R

1 Motion Blue LSM0603463V

1 PWR Green Green XZBGR155W5MAV XZBGR155W5MAV

1 R10 0402 100R CRCWO0402100RFK

1 R23 1005 0402 6.8k CRCWO04026K80FK

1 R24 1005 0402 27k CRCWO040227KOFK

1 Ul BGA, 42 BGT60LTR11AIP BGT60LTR11AIP
pins

1 Y1 FH3840024Z FH3840024Z

User guide 26 Revision 1.20

2024-10-17




(infineon

S2GO RADAR BGT60LTR11

XENSIV™ BGT60LTR11AIP Radar Shield2Go

PCB design

Qty | Designator Package Package Value Manufacturer order

metric imperial number
2 C1,C3 1608 0603 10 pF GRM188R61E106MAT3,
GRM188R61A106KE69

2 C5,C6 1608 0603 150 nF GRM188R61A154MA01

2 L1,L2 1005 600 R MMZ1005B601CT000

1 QS1: mode CJS-1200B1 CJS-1200B1

1 QS4: freq. CJS-1201B1 CJS-1201B1

2 R13, R20 0402 100 k CRCWO0402100KFK

2 R_QS2,R_QS3 10k 22AR10KLFTR

2 U4, U5 SN74AVC4T245DGVR SN74AVC4T245DGVR

3 R1, R2,R11 0402 330R CRCWO0402330RFK

4 C8,C9,C12, 1005 0402 10 nF GRM155R60J103KA01
C13

4 C10,C11,C14, | 1005 0402 5.6 nF GRM155R71E562JA01
C15

7 C2,C7,C17, 1005 0402 100 nF C1005X7R1H104K050BB
C18, C19, C20,
C21

7 R3, R6, R7, RS, 10k CRCWO040210K0FK
R12,R21, R22
R14,R17,R19 | 1608 0603 100 k RC0603FR-07100KL

3 R_QS1,R_QS4, 0603 OR RC0603JR-070RL
R9

4 R15,R16,R18 | 1608 0603 100 k RC0603FR-07100KL

2 R4, R5 0603 OR RC0603JR-070RL

1 S1 8-pin 8-pin, 2.54 mm pitch, male 2211S-08G

1 S1 9-pin 9-pin, 2.54 mm pitch, male 2211S-09G
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